
Introduction 
 

Loutext allows you to create seamless textures. The texture is made from 
pictures (tiles) which can be placed side by side (up/down, right/left) 
without any visible transition.   
 
Each month, a new release will be available. Those new releases can include 
enhancements arising from your remarks and ideas. 
 
If you need any help, have any remarks, any enhancement ideas, feel free 
to send me an email (luc.helie@wanadoo.fr). Have fun ... 
 
LouText 0.4 is a FreeWare. You can use it and the result textures as you want. 

 
 
Release 0.4: New functionalities 
 
REMARK !!! Structures and parameters places have change inside presets files. 
To be able to use your old presets you must first convert their structure to release 
0.4 structure using PCStruct04.exe, then use PCPrmtr04.exe to change 
parameters place inside the preset. If you have any problems with an old preset 
feel free to send me an email … 
 
OOPS !!! I didn’t mention that release 0.3 Perlin Noise module doesn’t produce 
seamless textures. All modules like “Perlin Noise” or “Chaotic functions” which don’t 
produce seamless textures appear in red in the module list. 
 
New modules 
 
Functions>Chaotic Functions 
 

Chaotic functions produce grey scale picture which are not seamless textures. The 
final result is by nature unforeseeable. 

 
 
Functions>Shapes>Filled>Circles 
 

Generate filled circles with saturation and luminosity gradients. 
 



Filters>Color Replacer>Gradient Fill 
 
 

"Gradient Fill" allows the user to replace a sequence of pixels of the same specified 
color by a gradient. 

 
 

Filters>Color Replacer 
 

The 2 color replacer filters « Color Replacer » and « Replace Null Color » have been 
moved to the « Filters>Color Replacer » menu item. 

 
 
Effects>Emboss 
 

" Emboss" allows to create a « traditional » emboss effect : an image which is 
stacked with a shifted negative.  

 
 
Effects>Grey Scale Colorize>Colorize 1 
 

Based on the luminosity channel of the last processed module « Colorize 1 » allow to 
colorize a grey scale image.  

   
 
Effects>Offset Effects 
 

" Offset Effects" compute for each pixel a new value which is based on the pixel 
himself (x,y coordinates) and another pixel which coordinates are X + ‘Width Effect’ 
and Y + ‘Height Effect’. Release 0.4 includes 5 algorithms. 

 
 
Effects>Outline 
 

" Outline" creates a luminous outline round picture areas. It works better with picture 
including large area of similar colors. 

 
 
Adjust>Ligthness/Darkness 
 

Negative values of the amount parameter allows to adjust picture darkness, positive 
value allows to adjust picture ligthness. 



Adjust>Levelling>HSL 
Adjust>Levelling>RGB 
 

« Levelling » allow to replace for each channels (RGB or HSL) values which are 
greater than « High value » by « High Value ». It also replace for each channels (RGB 
or HSL) values which are less than « Low value » by « Low Value ». Then 
« Levelling » allow to distribute the values (using the « Strech » parameter) between 
0 and 255 (or 359 for the hue channel). 

 
Geometric>Shuffle 
 
 

" Shuffle" randomly swaps pair of pixels. 
 



General remarks 
 
 
Color definition 
 
There are different ways to define a color. Loutext uses two of them : the RGB mode 
and the HSL mode. 
 
The RGB mode blends Red, Green and Blue to get a color. The quantity of red, green 
and blue can varies from 0 up to 255. 
 
The HSL mode defines a color by a Hue, Saturation and Luminosity. The Hue varies 
from 0 up to 359, Saturation and Luminosity vary from 0 to 255. 
 
Use of  RGB and HSL modes 
 
You can use RGB and HSL modules in the same texture. Module after module Loutext 
keep the state of your texture both in RGB and HSL mode. Having said that, converting 
a color from HSL to RGB then back to HSL doesn’t guarantee a return to the original 
values. So, it’s better (but not mandatory) to be consistent using RGB or HSL. 
 
Parameters 
 
In a lot of modules, you will have to define a min and a max value for a parameter. 
When you enter those parameters Loutext doesn’t verify that the min value is less than 
the max value, but during processing Loutext will invert those two parameters if the min 
value is greater than the max value. 
 



The Main form 
 
 
The main form is made of a menu and an image container work space. An image 
container allows to view the result of a texture processing. You can create several image 
containers, the active one will be used to display the processing result of the current 
texture.    
 

Main form menu 
 

Image  
 

New Create an empty image container which allows to view the 
result of a texture processing. 
 

Save Save the selected image in a bmp format file. 
 

BMP Format Allow to choose the color depth : 8, 16, 24 or 32 bits. 
 

Texture 
 

New Open the “ Texture form ” and create a new texture. 
 
Load Load a texture from a texture file (.lou extension) and open the 

“ Texture form ”. 
 
Save Save a texture as a texture file (.lou extension) 

 



The texture form 
 
 
The texture form allows you to define a texture through the combination of modules (up 
to 200). The texture form is made of a menu and 4 panels : “ Parameters ”, “ Colors ”, 
“ Modules ” and “ Blending ”.  
 
The “ Modules ” panel is a list of modules which are processed from top to bottom to 
create a texture. 
 
The “ Parameters ” and “ Colors ” panels define all the parameters of the “ current 
module ” which is identified in the list by a gold disc in the second column of the 
modules list.  To go from a module to another, you just have to click on the name of the 
module 
 
Just under the “ Modules ” panel, you will find 5 buttons : 
 

Process  process the texture from the first module to the current module 
Up/ Down arrows  

move the current module up and down through the list 
Active define if the current module is active or not. Inactive module are 

shown by an “X” in the third column of the modules list. 
Remove  remove the current module 
 

The “ Blending ” panel defines how the current module and the preceding module are 
blended. Blending takes place at the module indicated by the green and red squares in 
the second column of the modules list. 
 

Texture form menu 
 

The “ Texture ”, “ Functions ”, “ Filters ”, “ Adjust ”, “ Geometric”, “ Buffers ” and 
“ Layers ”  menus allow to add new modules to the list. The “ Color Channels ” 
defines which image channel (Color, HSL or RGB) will be display in the image 
container. 
 
Remark : The “ Buffers>Move to buffer ” function allows you to save the current 
state of the texture and recall it later using “ Buffers>Recall buffer ”. Typically, it 
lets you create two (or more) branches of a texture and then mix them. 
 
 

Parameters Panel 
 

Each parameter can be defined via a Scrolling Bar or a ComboBox. For Scrolling 
Bar parameters you can also type the value into the associated  text field.  



Colors Panel 
 

Some modules need color parameters (background, foreground …). You can 
introduce those colors parameters in the “ Colors ” panel. To modify the default 
colors you just have to click on the color box to open a choose color dialog. 

 
Modules Panel 

 
The Modules panel is made of three columns. The first one gives the name of the 
module. The second one specifies the current module by an X. The third column 
specifies if the module is active or not. 

 
Blending Panel 

 
The “ Blending ” panel defines how the current module and the preceding module 
are blended. Each layer (HSL or RGB) can be blended with a different parameter 
which is accessible through one of the three ComboBox (Red/Hue, 
Green/Saturation and Blue/Luminosity). The “Randomize” button will produce a 
random choice of blending parameters for the three layers of the current module. 
 
The “Mode” ComboBox defines if the blending is made in RGB or HSL color 
definition.  
 
The “Result Layer” and “Current Layer” ScrollBars define the opacity of those 
layers. 
 
If the transparency color is applied all pixels of the Current Layer of that color are 
replaced by the Result Layer pixels with no blending. 
 
 
The “Rand. Blend.” button creates a random choice of blending functions for all 
the modules. 
 
The “Rand. Opacity” button creates a random choice of opacity values for all the 
modules. 
 
The “Rand. All” button creates a random choice of blending functions  and opacity 
values for all the modules. 
 
The 3 buttons “Rand. Blend.”, “Rand. Opacity” and “Rand. All” automatically start 
the texture processing. 

 



The “ Texture ” form menus 
 
Functions 

 
Chaotic Functions 

 
« Fx 2 A » to « Fx 2 F » chaotic functions have the same parameters. Those 
functions don’t produce seamless textures. The final result is a grey scale 
picture.  

 
Remark : 

 
‘Details’ and ‘Luminosity’ parameters default values are optimized for 512 x 
512 pictures.  

 
Parameters : 
 

‘Width Effect 1’ / ‘Height Effect 1’  
Chaotic algorithm parameter 1 (width and height effects).  

 
‘Width Effect 2’ / ‘Height Effect 2’  

Chaotic algorithm parameter 2 (width and height effects). 
 

‘Details’  
Define the details level of the final picture. Be careful, high values are time 
consumming and do not necesseraly give better results. It depends on the 
function parameters. 
  

‘Luminosity’  
Define the luminosity level of the final picture.  

 
‘Random seed’  

Random generator initial value 
 

‘Width – Left Offset’, ‘Width – Right Offset’,  
‘Height – Top Offset’, ‘Height – Bottom Offset’  

Allow to define the rectangle limits where the chaotic functions is drawned. 
 

 
Noise 

Create a texture made of randomly colored pixels. The noise can be controlled 
limiting the range of values for each channel (HSL or RGB) through the min and 
max parameters. The “ Rate ” parameter defines the percentage of pixels which 
are initialized by a random color. The color parameter “BckGrnd” will be used for 



pixels which are not initialized. 
 

Perlin Noise 
 

The "Perlin Noise" function generates a grey image from a Perlin noise which 
can be defined using 6 separate frequencies. 
 
The final result is the sum of the 6 frequencies. Each frequency is moderated by 
the "Amplitude" parameter. Frequencies with a "Frequency" parameter or an 
"Amplitude" parameter equal to 0 are not processed.  
 
The R,G and B channels contain equal values from 0 to 255 which define a grey 
level. In HSL mode, the Luminosity channel contains the function values, the 
saturation and the hue channel are set to 0. 
 
Parameters : 
 
'Frequency' :  Grey variation speed.  
 
'Amplitude' :  Frequency weight. 
 
'Scale' :  X and Y values scale. By default, values are 1,2,3,4 .... "Scale" 

is used as a divisor to get thinner values, i.e. if "Scale" is equal 
to 5 X and Y values are 0.2, 0.4, 0.6, 0.8 .... "Scale" can be 
also be perceived as a Zoom factor. 

 
'Random Seed' Random generator initial value 

 
 

Periodic Functions 
 

The channels values (H,S,L or R,G,B) are obtained from the values of a periodic 
function  (Sine, Triangle, Saw Tooth, Square). 



Shapes>Wire>HSL Variations>Polygons 
 

"Polygons" generate irregular polygons whose outlines can vary through a hue, 
saturation and luminosity variation. 

 
Parameters : 
 
'Occurrences'  Lines number 
'Hue Range'  Hue range (+ / - 'Foreground' hue) 
'Hue Step'  Hue variation speed during the drawn of a line 
'Saturation Range' Saturation range (+ / - 'Foreground' Saturation ) 
'Saturation Step'    Saturation variation speed during the drawn of a line 
'Luminosity Range'  Luminosity range (+ / - 'Foreground' Luminosity )       
'Luminosity Step'     Luminosity variation speed during the drawn of a line 
'Minimum Length'   Line minimum length 
'Random Seed'     Random generator initial value 
 
'Background color' Background color 
'Foreground color' Outlines base color 
 
 

Shapes>Wire>HSL Variations>Rectangles 
 

Generate wire rectangles whose outlines can vary through a hue, saturation and 
luminosity variation. 

 
Parameters : 
 
'Width Min' Rectangles minimum width  
'Width Max' Rectangles maximum width  
'Height Min' Rectangles minimum height  
'Height Max' Rectangles maximum height  
'Occurrences' Rectangles numbers 
'Hue Range'  Hue range (+ / - 'Foreground' hue) 
'Hue Step'  Hue variation speed during the drawn of a line 
'Saturation Range' Saturation range (+ / - 'Foreground' Saturation ) 
'Saturation Step'    Saturation variation speed during the drawn of a line 
'Luminosity Range'    Luminosity range (+ / - 'Foreground' Luminosity )       
'Luminosity Step'      Luminosity variation speed during the drawn of a line 
'Random Seed'     Random generator initial value 
 
'Background color' Background color 
'Foreground color' Outlines base color 



Shapes>Wire>Monochrome>Rectangles 
 

Generate wire rectangles with monochromatic outlines. 
 
Parameters : 
 
'Width Min' Rectangles minimum width  
'Width Max' Rectangles maximum width  
'Height Min' Rectangles minimum height  
'Height Max' Rectangles maximum height 
'Hue Min' Minimum hue value 
'Hue Max' Maximum hue value 
'Saturation Min' Minimum saturation value 
'Saturation Max' Maximum saturation value 
'Luminosity Min' Minimum luminosity value 
'Luminosity Max' Maximum luminosity value 
'Occurrences' Rectangles numbers 
'Random Seed'     Random generator initial value 
 
'Background color' Background color 

 
Shapes>Filled>Rectangles 
 

Generate filled rectangles with saturation and luminosity gradients. 
 

Parameters : 
 
'Width Min' Rectangles minimum width  
'Width Max' Rectangles maximum width  
'Height Min' Rectangles minimum height  
'Height Max' Rectangles maximum height 
'Hue Min' Minimum hue value 
'Hue Max' Maximum hue value 
'Saturation Min' Minimum saturation value 
'Saturation Max' Maximum saturation value 
'Luminosity Min' Minimum luminosity value 
'Luminosity Max' Maximum luminosity value 
'Occurrences' Rectangles numbers 
'Luminosity Gradient Mode' Luminosity gradient orientation 
'Saturation Gradient Mode' Saturation gradient orientation 
'Random Seed'     Random generator initial value 
 
'Background color' Background color 
 



Shapes>Filled>Circles 
 

Generate filled circles with saturation and luminosity gradients. 
 

Parameters : 
 

‘Radius Min’ / ‘Radius Max’   
The circle radius is randomly generated between ‘Radius Min’ and ‘Radius 
Max’. 

 
‘Thickness Min’ / ‘Thickness Max’ 

The circle thickness is randomly generated between ‘Thickness Min’ and 
‘Thickness Max’. 

  
'Hue Min' / 'Hue Max'  

The circle hue is randomly generated between ‘Hue Min’ and ‘Hue Max’. 
 

'Saturation Min' / 'Saturation Max'  
The circle saturation is randomly generated between ‘Hue Min’ and ‘Hue 
Max’. 

 
'Luminosity Min' / 'Luminosity Max'  

The circle luminosity is randomly generated between 'Luminosity Min' and 
'Luminosity Max’. 

 
‘Occurences’  

Circle numbers 
 

‘Luminosity Gradient Mode’  
Luminosity gradient orientation 

 
‘Saturation Gradient Mode’  

Saturation gradient orientation 
 

‘Random seed’  
Random generator initial value 

 
'Background color'  

Background color  
 



Twigs 
 

Create “ Twigs ” with parameters for length, orientation, hue, saturation and 
luminosity variation. 



Filters 
 

Matrix Filters 
Replace each pixel by a value obtained from a matrix centered on the pixel, for 
instance the average of the matrix pixels. A “Matrix Size” of 1 defines a 3 x 3 
matrix, 2 defines a matrix of 5 x 5 pixels, 3 defines a matrix of 7 x 7 pixels, 4 
defines a matrix of 9 x 9 pixels and 5 defines a matrix of 11 x 11 pixels.  
Be careful, a value of 5 implies that each pixel is computed from a matrix of 120 
pixels, which means for a 512 x 512 texture 31,457,280 elementary 
operations !!! 
 
 

Conditional Average 
Replace the channel value of a pixel by the average of the matrix centered on 
the pixel. This is done if the offset between the average and the channel value 
is greater than the “offset” parameter. 
 
 

Invert 
Invert one or more of the H,S,L channels (or R,G and B) of each pixel 
depending on a condition which limits the pixels that will be inverted. A channel 
is inverted by subtracting its current value from its maximum value (359 for the 
hue and 255 for other channels). To get a negative image, just invert the 3 RGB 
channels without any condition. The invert operation of a pixel is done if the H,S 
and L pixel values are inside the H,S,L ranges. The 3 values must be in the 
ranges if the condition is “And”  or only one if the condition is “Or”. 

 
 

Color Replacer>Simple Color replacer 
Replace the “ Color ” color with a tolerance on each channel by the “ Replaced 
by ” color. 

 



Color Replacer>Replace Null Color>HSL 
Color Replacer>Replace Null Color>RGB 

Replace a color (“ Null Color ” parameter) by variations which are linked to other 
colors, to the algorithm and to random variation ranges authorized for the H, S 
and L channels  (or R,G and B). 
 
Parameters : 
 
'Negative Hue Variation' : Hue random variation range around the 

computed value  
'Positive Hue Variation' : 
 
'Negative Saturation Variation' : Saturation random variation range around 

the computed value 
'Positive Saturation Variation' : 
 
'Negative Luminosity Variation' : Luminosity random variation range around 

the computed value 
'Positive Luminosity Variation' : 
 
'Algorithm' : 2 algorithms are available 
 
'Random seed' : Random generator initial value 
 
'Null Color' : Color to be replaced 

 
 
Color Replacer>Gradient Fill 

 
 

"Gradient Fill" allows the user to replace a sequence of pixels of the same 
specified color with a gradient starting from the value of the pixel preceding the 
first pixel of the sequence and ending with the value of the pixel immediately 
following the sequence. For instance, imagine a row extract which looks like 
this : 

 
… 189 120 140 140 140 140 140 140 140 140 210 156 … 
 

If the « Replaced Color » has a value of 140, the « Gradient Fill » algorithm will 
give the following result : 

 
… 189 120 130 140 150 160 170 180 190 200 210 156 … 

 
Parameters : 
 



‘Algorithm’  Currently only one algorithm is available : « Linear 
Morphing » 

‘Orientation’ Four orientations are available (Horizontal, Vertical and 
the two 45 degrees diagonals) 

 
 
Conditional Average 
 

Replace the channel value of a pixel by the average of the matrix centered on 
the pixel. This is done if the offset between the average and the channel value 
is greater than the “offset” parameter. 



Shapes>Rectangular Tiles 
 

"Rectangular Tiles" create rectangular tiles modifying the preceding process 
module (if any). 
 
Parameters : 
 
'Width Period' :  Width tiles number 
'Height Period' :  Height tiles number 
'Thickness' :  Tile border thickness 
'Luminosity' :  The border is created by a variation of the 

luminosity. 'Luminosity' is the start value which 
increase or decrease more or less quickly 
depending on 'Luminosity Variation' parameter. 

'Luminosity Variation' :  See above. 
'Tile Orientation' :  4 orientations are available in the ComboBox 

parameter. 
'Luminosity Orientation' :  Define if the luminosity will increase or decrease 

creating the tile border. 
 

Transfer Functions>Sine Fx 
 

Transfer functions compute the value of a function from the value of each pixel 
for one or several channels. This value replaces the pixel value. 

  
Parameters : 

 
'Channels' RGB or HSL 
'Apply to Red / Hue' The filter is applied or not to the 'Red' channel 

(or 'Hue' depending on 'Channels' parameter) 
'Apply to Green / Saturation' The filter is applied or not to the 'Green' channel 

(or 'Saturation' depending on 'Channels' 
parameter) 

'Apply to Blue / Luminosity' The filter is applied or not to the 'Blue' channel 
(or 'Luminosity' depending on 'Channels' 
parameter) 

'Algorithm' 3 algorithms based on sine functions 
'Parameter 1' Sine function parameter 1 
'Parameter 2' Sine function parameter 2 



Effects 
 

Emboss 
 

" Emboss" allows to create a « traditional » emboss effect : an image which is 
stacked with a shifted negative.  
 
Parameters : 
 

‘Width effect’ Width shift / offset 
‘Height effect’ Height shift / offset 
‘Stretch' Distribute the RGB channels values from 0 to 255. 

 
 

Grey Scale Colorize>Colorize 1 
 

" Colorize 1" algorithms are based on the luminosity channel of the last 
processed module.  

 
Remark : 
 

Depending on the ‘Base color’, different values of variant parameters can give 
same result. 

 
Parameters : 
 

‘Variant 1’, ‘Variant 2’ , ‘Variant 3’ and ‘Base color’ are the 4 algorithm 
parameters.  

 
  

 
Offset Effects 

 
" Offset Effects" compute for each pixel a new value which is based on the pixel 
himself (x,y coordinates) and another pixel which coordinates are X + ‘Width 
Effect’ and Y + ‘Height Effect’. Release 0.4 includes 5 algorithms. 

 
 

Outline 
 

" Outline" creates a luminous outline round picture areas. It works better with 
picture including large area of similar colors. 

 
 



Adjust 
 

Contrast  
Adjust the texture contrast. 
 

Color Balance 
Modify the texture colors by a balance between Cyan and Red, Magenta and 
Green, Yellow and Blue.  

 
Levels 

Distributes the values of a channel from min value to max value. 
 

Levelling>HSL 
Levelling>RGB 

 
« Levelling » allow to replace for each channels (RGB or HSL) values which are 
greater than « High value » by « High Value ». It also replace for each channels 
(RGB or HSL) values which are less than « Low value » by « Low Value ». Then 
« Levelling » allow to distribute the values (using the « Strech » parameter) 
between 0 and 255 (or 359 for the hue channel). 

 
 

Ligthness/Darkness 
 

Negative values of the amount parameter allows to adjust picture darkness, 
positive value allows to adjust picture ligthness. 

 
 

Geometric 
 

Mirror 
Horizontal mirror of the texture. 

 
Flip 

Vertical mirror of the texture. 
 

Offset 
Sets displacement in pixels on X and Y axes. 
 

Shuffle 
" Shuffle" randomly swaps pair of pixels. It’s possible to control the swaps 
through 2 limits :  

- the distance between the pixel of origin and the target pixel 
- the 3 channels value difference between the 2 pixels 

 



Parameters : 
 

'Apply To'  
Apply the swaps to HSL or RGB channels 

 
'Hue/Red max diff'  

Don’t swap the pixels which Hue/Red difference is greater than this 
parameter 

 
'Saturation/Green max diff'  

Don’t swap the pixels which Saturation/Green difference is greater than 
this parameter 

 
‘Luminosity/Blue max diff'  

Don’t swap the pixels which Luminosity/Blue difference is greater than this 
parameter 

 
'Width min distance'  
'Width max distance'  
'Height min distance' 
'Height max distance'  

Limit the distance between the 2 pixels 
 

'Occurences'  
Swap numbers 

 
'Random Seed'  

Random generator initial value 
 

Buffers 
 

Move to Buffer 
Save the current state of a texture in one of the 3 buffers. 
 

Recall Buffer 
Recall a texture saved in one of the 3 buffers. 
 

Layers 
 

Invert Channels 
Invert two channels of a texture.  

 
Move Channels 

Replace a channel by another for all texture pixels. 



 
Color Channels 

 
The “Color Channels” menu allows to define which channel (H, S or L, R, G or B) 
will be displayed in the texture image. 
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